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What is an ActionScript?
The web design community strives to make internet applications which are eye-catching and appealing to computer users of all ages. Knowledge of the programming language ActionScript gives web designers a greater ability to generate appealing applications.

BY ANTHONY MARTINEZ
1. Introduction
Modern time has created a world which requires people to use computers daily. Almost everybody will have to use a computer during some point of the day. This can be either a student at a University or an employee working for a corporation. Probably, the most common computer use is the internet. The enormously large computer network these users utilize to seek research, communication, entertainment, or employment opportunities. The first time data exchanged between computers host-to-host occurred in 1969. A computer belonging to the Network Measurement Center at UCLA sent a message to a computer belonging to Stanford Research Institute (SRI). This advancement led to the building of a TCP/IP-wide area network constructed on January 1, 1983. Many feel this was the birth of the internet.
 

During these early days, the internet was not at all like it can be today. Most of today’s user would probably view yesterday’s internet as extremely boring. The internet could only display text on the screen. It was impossible for the internet to do anything else. The early internet lack the capability to display interesting images, sounds, or interactive web pages. It could only show simple text. Of course, it could display a lot of text but still that can only go so far with the human attention span. Email became the most popular program.
 Also, the audience of the internet was small. The people connected were only other people who worked for the government. Unlike today, the Internet was not the place for entertainment. The internet was a place for communication to be established between remote locations. An ideal the military thought was important. 
1.1 Early Internet Limitations


Of course, just like a newborn child can not run after being born neither could the internet. The internet had text-only display because of a couple of factors. These were computer hardware and internet connections.

One can guess computer hardware during this time was nowhere near as advanced as today’s hardware and it showed. Today, a user alone can have a video card, like the BFG Technologies GeForce 8800 GTX video card,  to view internet material. A card like contains a dedicated Graphics Processing Unit (GPU) and 768 MB of memory directly installed on the card.
 The internet was born before the 1 MB memory chip which did not occur until 1984.
  Besides system RAM, all other aspects of the computers hardware were limited too. 


Also, today’s user can view the internet with the capability of a T1 line compared to what was available in the beginning. This was using the phone line without the benefit of packet switching. A very slow process.

Since these hardware factors created the availability of software was limited too. Obviously, software companies did not want to spend time and money on a product which could not be used due to inadequate hardware. So there were no webpage developing programs like Microsoft’s FrontPage, or Macromedia’s Dreamweaver, Fireworks, Coldfusion, or Flash. 
1.2 The Need to Change

The world is a changing entity. Commonly, a lot of things do not stay the same and changes occur. Thankfully, this was the case for the internet. Quickly, more and more people envisioned the internet could do more than display text and pass along email messages. This increased number of people led to a high demand which generated better computer hardware, faster internet speeds and advanced software programs. There are now software companies thriving from creating software dedicated to internet applications. Hopefully, demand will always be high so the envelop keeps being pushed and advancements in computer applications can do keeps advancing.

A positive change came when the internet went from displaying text-only to our modern-day internet because new employment opportunities were created. 


This change gives a person the chance to find employment through companies who build computer parts or full systems designed for internet use, or at an Internet Service Provider (ISP) helping out with daily routines in order to provide internet connections to the public, or for a software company which designs internet-based software applications, or by being a person who uses all of the above mentioned groups to create original web pages like graphic artists and web designers. 

Personally, I have found employment from the latter group. This type of work is enjoyable and rewarding because it allows the opportunity to think of an ideal then utilize computer software to make that ideal become a reality. 

In order to have the ability to do computer graphic work requires an individual to spend countless hours reading books on software programs and then spending time putting that knowledge to use by creating actual applications. 
Individuals lacking this motivation will only create ordinary and boring work. In today’s market, this could bring a quick a quick end to your computer graphic career because of  ever growing competition. The majority of people using the internet today share the same attention span as a goldfish. This short attention span is nine seconds which means if your work does not grab their attention then your work will be quickly overlooked towards more entertaining content.
  The reason a person needs to grasp as much knowledge possible of all available tools. The knowledge will assist in creating professional quality and meaningful work. 

Recently, I have spent most my time reading and using a program known as Flash. Flash books frequently mention something called ActionScript. They state this programming language can provide the means to make applications more powerful, diverse, and interactive. ActionScript has the ability to provide assistance with all details of web work. Books state the possibilities are endless ranging from webpage layouts to creating animated movie clips.

Many people do not take the steps to learn ActionScript. Unfortunately, it is common for people to assume action scripting is too complicated. They think this type of programming is only done by nerdy people. Some say using Flash without ActionScript can be compared to having a feast using a single burner in a gourmet kitchen 
 

2. Background

ActionScript is a programming scripting language meaning it is event driven.  An event occurs when a user performs an action within the webpage. For example, an ActionScript could be executed when a user enters text into a textbox then proceeds to press a button. The button being pressed produces an action which triggers an event like grabbing the data entered in the textbox and storing the date in a database. 
Before we get into how to use this language lets examine how ActionScript came to be.

2.1 Historical Perspective 
In 1992, a business merger occurred between Authorware Inc.  and MacroMind-Paracomp creating a new company named Macromedia. This company was headquartered in San Francisco, California. Multimedia created by computers had taken off with the production of interactive CD-ROMs. The merger of the two companies occurred when the CD-ROM market was beginning to decline and the use of the internet among the general public was growing. Macromedia envisioned the internet’s big potential of being the medium of the future for multimedia applications. Immediately, they decided to drop all their CD-ROM projects and put their focus on projects to develop web-native media tools directly for web designers.


The team at Macromedia created software programs called Dreamweaver, Fireworks, and Flash. Dreamweaver is a HTML editor program providing a user both visual and code support. It is the company’s most used program. Fireworks is a graphic editor program and Flash is a program capable of making 
Logos, web pages, games and animations geared to display on the internet.


Flash is a very interesting creation. It is a multimedia authoring program that creates vector-based graphics.  Vector graphics shapes are made by using geometric primitives like points, lines, curves, and polygons.
 This method of graphics generates small file sizes which is ideal for internet display. File size is small because only mathematical equations have to be saved to the SWF files. These are the default output files Flash creates. These files are known as the “distributable” files because they can be distributed without needing to contain any source files.
 The graphics are generated from the saved mathematically equations that are executed at runtime by a Flash player. Another pro to vector graphics is they can be scaled to different sizes without losing any of its detail.
 The other method of graphics is called Raster graphics. Raster graphics use bitmaps to create shapes. A bitmap is a collection of pixels making up some shape. The shapes are made by arrays of pixels. These arrays require more memory. Also, they lose detail when modified. Flash can support raster graphics, when imported into the workspace, but when shapes are created within its authoring environment they are vector-based.

The first version of Flash hit the market in 1996. Similar to the internet, Flash in the beginning showed to be limited with its capabilities. Quickly, people wanted to do more with the program. Many wanted their animations to be interactive. In 2000, Macromedia released Flash 5. Included in this bundle was a program called ActionScript 1.0. This was the answer to make animations interactive and help influence a boom of online interactive multimedia.

ActionScript is a scripting language based on the ECMAScript. This is more commonly referred to as JavaScript because it is the biggest implementation using the ECMA-262 specification. By 1959, the use of computers was going strong and several computer manufactures existed. Some saw the need to have computer operations be standardized. This included standard for computer programming. For example, they wanted the input/output coding for one manufacture’s computer to be the same for computers produced by different manufactures. This would eliminate duplicate work and save valuable time which would otherwise be spent making alterations to coding. The heads of computer companies invited representatives of all European manufactures for a meeting. The meeting was held in Brussels on April 27, 1960. The outcome of this meeting was to create an association of all European manufactures called European Compact Manufactures Association (ECMA) and to create a committee to discuss the bylaws and rules of the standards.
 Now, over forty years later the ECMA is an international group still focusing on keeping standards in Communication Technology (ICT) and Consumer Electronics (CE).

As mentioned, ECMA-262 was the standard set for scripting languages. JavaScript, a registered trademark for Sun Microsystems,
 is the biggest implementation of it. This is why JavaScript works on almost all web browsers. ActionScript developers wanted to have the same benefits of compatibility, like JavaScript, so they based it on the ECMAScript to ensure it could work on most computers.
2.2 Relevant Research


In 1999, computer graphics sparked an interest to me. I pursued this interest by enrolling into the computer animation program at Albuquerque TVI in New Mexico. This program introduced me to everything I have seen with computer graphics. My introduction to Adobe’s program was my first taste of graphic work. First, I learned how to use Photoshop and Illustrator then we were taught how to use 3D programs like Alias Wavefront Maya and Newtec Lightwave. We were taught a program like Photoshop first because they wanted us to learn how to create texture maps to be used on objects in the complicated 3D programs. After they taught us how to use the graphics programs they started to teach us how to make animation following certain design concepts. For example, we learned the important concept of storyboarding. This concept is where you draw out your animation ideal to quickly convey your message to someone. A storyboard is extremely helpful to map out what scenes you what to create. My time spent in this animation program taught animation has a great potential for many uses like as an entertaining teaching tool. What is better than an entertaining informative cartoon? It is also the time where I first heard about the ideal of using a program language to help out with projects. The 3D program Maya contains a language called Maya Embedded Language (MEL). Mel is a scripting language which is capable of doing everything a user can do using the GUI.
 Ironically, my computer programming skills were nonexistent. My assumption about using MEL was it was too advanced and out of my league. 

I graduated the program with an Associates degree and left for Colorado to become a ski bum while working on my demo reel. Unfortunately, time went by quickly which saw my snowboarding skills improve dramatically but slowing my 3D computer skills did the opposite. The statement “what you do not use you lose” is true. Before I knew it my computer hardware and knowledge had become outdated. I was out of the 3D realm.

My computer skills getting very limited realization sparked motivation to go back to school. I enrolled at Fort Lewis College (FLC) in Durango, Colorado majoring in computer information systems and with an art minor. Computer graphics was not an option at this school so I took on new areas of computer study. These included database management and software development. Besides the required computer classes the FLC catalog requires students to take thematic studies (TS) classes to develop a well rounded education. These general classes introduce students to the other areas of studies within the college. The classes are broken up into four categories. The categories consist of Technology, Culture, Environment, and Systems. Students are required to take one class from each group to meet graduation requirements. These classes introduce students to new information and topics outside their own major which, most likely, would not be learned. An unfortunate side effect, these classes became repetitive. The subject matter of each TS class are always varies but the method of coursework repetitively was the same. TS classes always required a final paper and presentations. The presentations always involved having a Microsoft Power Point to give slideshow presentations to the class. Many different examples of PowerPoint presentations are created for these classes. Some presentations are good and some are bad. Personally, the repetitive nature of these classes triggered the desire to create something different and not use PowerPoint. 

During this time, I used the on-campus computer labs while attending FLC because of not owning my own computer. One day, my desire influenced me to look into Design and Presentation folder on a college computer. This move led to the accidental discovery of Macromedia’s Flash program. I clicked the program to see what the Flash program was all about. The program loaded and immediately the timeline stood out to me. Also, I noticed the toolbar on one side and the design panels on the other side of the screen. Design panels contain features like color swatches. There are buttons located right by the timeline. The toolbar, layers, and design panels look very similar to Adobe Photoshop and Illustrator. The timeline was similar to Maya and Lightwave. Feelings of excitement traveled through my veins while examining this newly discovered program. The similarities to other programs gave insight about this program having the potential to create something different for presentations.

After discovery, my time was invested into reading more about Flash and the discoveries continued. I found out the people at Macromedia are a nice and considerate bunch because they offer lessons on how to use the program. When Flash is first loaded the title screen is displayed. The title screen is the screen where a user can select to open an existing file or create a new file. The lesson link located on the bottom left side of this screen. Clicking this link will take a user to the lessons section. Note, if you do not see the lesson link on the title page or down right do not see any title page the lessons section can be found by clicking  the create a new document link followed by selecting Help-> Working with Flash. Once this window is opened a user will see how much documentation the program conveniently has for them to read. There is information on getting started, like installing the program (which is a bit odd because to see this documentation you need to have the program successfully installed), information on using Flash, using components and using ActionScript. You will notice there is even an ActionScript dictionary (A-X) available for users to use. Researching this documentation will teach the basics needed to start working with the program. After learning the basics you can move onto searching the internet for tutorials to learn more on how to use the tools to create applications. Investing in some books about the version of Flash you have running is very helpful. These provide good background knowledge of the program and some books have lessons in them.

After spending a good amount of time reading and practicing Flash put me back into the using computers for creating mood again. My head was coming up with ideas for movie clips. Soon, I was making storyboards again. I went on to make a few movie clips. The first ones made were very small. Flash allows you to make more than one scene. My first movie clips were only one scene long. In 2003, I finished my first Flash project from original idea to finished clip. This is an animation titled “Big Bang Theory”. This Flash clip has eleven scenes.
 Creating this Flash clip reminded of how creating animations can take a very long time but proved it was possible to make something unique for presentations. My creations included clips like the reason why the Indian Boarding school was created, an attention grabbing introduction with a natural corn seed getting ready to box a genetically modified opponent followed by a who-am-I game show clip for a bioengineering class. 
These creations required a lot of practice and reading. After awhile, I noticed the Flash books shared the frequent mentioning of ActionScript. They say more can be accomplished if you incorporate ActionScript coding into your applications. This brought up the idea from my past about how MEL could help with MAYA projects. The idea I had of assuming the task too difficult led to me never learning how. How valuable it could have been if I did learn. It seems like this is a second chance for me to learn how to use coding within a graphical program. Sure, Flash is no MAYA but nevertheless it provides the opportunity to animate and this is the area where I want to focus my research. 
2.2.1 Scholarly Research

Reviewing most college catalogs shows ActionScript is not a common subject taught. More commonly, programming classes focus their teaching using languages like Java and Visual Basic. These programs are the standards for learning the concept of object oriented programming. However, there are some schools that teach ActionScript but some time researching for them is necessary. 

In 2001, when I earned my Associates degree the availability of pursuing a four year degree in computer animation was nonexistent. Today, a search for computer animation bachelor degrees shows the availability of many different programs. After more time, I envision Flash use will continue to increase eventually Flash and ActionScript will be incorporated into more curriculums of schools.

My thought is if a person has a general idea on how to use a computer they can probably learn ActionScript by performing independent research from reading books. Although not one hundred percent necessary, anyone who has spent time learning a programming language following object oriented programming can easily make the transition to learning how to use ActionScript.  For most people, this is the best option.
2.2.1 Industrial Research

Flash started off as a program only capable of showing graphics and animations. The demand to have interactivity with the Flash clips soon appeared. This demand led to the development of ActionScript. Version 1.0 came out in 2000. Research continued and improvements were made. ActionScript 2.0 was released in 2004. More recently, ActionScript 3.0 is being released with the newest version of Flash. 

To show how important this software is can be seen in how much money Adobe spent to buy out Macromedia. Adobe, a former competitor, made an agreement to acquire Macromedia in a stock swap. The value was $3.4 billion.


The advancements of Flash utilizing ActionScript in regards to processing data within web forms and the potential this has will only continue to push Adobe to continue  industrial research to ensure the large sum of money spent on these internet-based software programs was worth the expense.


Also, A Flash player plug-in is required to be downloaded and installed in order for Flash content to be displayed on a computer. The Flash Player is the program which interprets the instructions Research is done to keep making improvements to the Flash player. These players are available free of charge and can be downloaded from the website: 
http://www.adobe.com/shockwave/download/download.cgi?P1_Prod_Version=ShockwaveFlash

Negatively, Flash and ActionScript have taken some bad heat from use by aggressive online advertisers. These groups have led to the development of Flash blockers which do not allow Flash, including ActionScript, to be displayed in a web browser.
 Aggressive advertisers do create the need to have some type of blocker program but not all Flash/ActionScript work is attributed to them. The blocker programs blocks all Flash work. This creates a situation where a lot of good work is being overlooked. The need for the development of filters to show good Flash work and not the intrusive materials should be researched and developed.


3. How to Use ActionScript


ActionScript is a program located within a program. Primarily, it is found within versions of Flash 5 and higher but is also found in a program called Coldfusion. Coldfusion is a program geared to working with databases and web forms.
 Theoretically, you could type ActionScript code in any text editor but this method is not highly recommended due to not having the benefits of color-coding terms and use of the debugger. To achieve productive and successful work calls for a couple of requirements to be satisfied before any creating can be made.
 3.1 Requirements

The requirements require a high performing computer and software. The minimal computer requirements should be looked up and ensured the computer planed to run Flash meets the requirements. Failing to do this can result in high levels of frustrations. ActionScript 2.0 is the version I have been researching. This version of ActionScript was released with Flash MX Professional 2004. This version of Flash requires these minimal system requirements to run properly
:

· Pentium III 500 MHz processor or better (dual Pentium 4 or faster recommended) 

· Windows Server 2003*, Windows 2000 Server, Windows NT 4.0 Server (SP6 or later), Red Hat Linux 7.3, 8.0 or Red Hat Enterprise Linux 3.0* 

· 256 MB Available RAM (512 MB Recommended) 

· 50 MB of available disk space 

· CD-ROM Drive (optional) 

Next, to use Flash requires the program to be purchased and installed on the computer. Without the program installation you will go nowhere. To purchase Flash one can visit the Adobe store on their website.
 Of course, you can use Flash and avoid paying the purchase price if you attend a school which has it installed on their computers like FLC. Remember, you will need to purchase your own license if you plan to use it to make money because a person can only make applications for the learning experience using school software. 
3.2 Macromedia Flash MX        

      Professional  2004

Macromedia Flash MX Professional 2004 is the version used for my research. The reason is because there are many books and other resources available about this established version.

Flash MX is an environment where a user can create animations or computer graphics with the potential to have interactivity. Flash was developed to create web pages, its planned main activity, but can also be used to create cartoons and computer games. Creations are made by creating a series of frames that get played like they are in a movie. Each frame contains instructions which are interpreted by a Flash player during its runtime. Flash is an editor. The workspace allows a user to make and test Flash movies. 

There are two different methods in developing movies in Flash. The more common method is to use Flash’s graphical user interface (GUI). This is done by using a mouse, or some other pointing device, to draw, make selections, or perform modifications to shapes. The other method to develop is done by programming actions with the built-in language ActionScript.
The latter method is less commonly used because of a smaller group of using this programming language. When a user knows how to equally use each of these methods they will be able to decide when and which method to use for creating applications. Sometimes, creations require using both methods together.
3.3 First Use of ActionScript

To get started requires Flash to be opened. When the program is opened the title screen will be displayed. The title screen provides the option to open an existing document/project, create a new one, or open a provided template and finish it. For my research the second option was always selected. Once the document/project is loaded into the workspace the access to the ActionScript window is allowed. To open the ActionScript window is done by selecting select Window ->Development Panels ->Actions or by pressing F9. This will open the ActionScript window. Look for it below the workspace area. Clicking inside this window will make it active and allow for coding to be typed. Examining the ActionScript window a person will see a typical typing area. This is the text editor and is the location where all ActionScript coding is placed. Text which is typed in this allocated space will have keywords get color coded like other programming text editors. 

Towards the left of the text editor window is a scrollable window containing all available functions, properties, operators, etc. which Action Scripting contains. This window is a very valuable resource to provide assistance with ActionScript coding. If a user wants to use this window only requires the user to select the desired element from the window and drag it over to the text editor window or double click it to place it in the ActionScript window. For example, if a user wants the Flash clip to stop at frame 10 they perform the following action:
1. User will need to click frame 10 on the timeline in the Flash workspace

2. Hit F5 to place a keyframe in frame 10 (A keyframe is needed to be created on the frame where you plan to place ActionScript code. If we skip creating a keyframe then the ActionScript would be placed on the default frame which is frame 1
3. Ensure the ActionScript window is open by pressing F9
4. In the scrollable window located to the left of the text editor look for the “Global Functions” category and click it 

5. Clicking the “Global Functions” category should trigger a collapsible list to appear. This list should show different categories of functions. This list has seven categories. They are listed in the following order: Timeline Control, Browser/Network, Movie Clip Control, Printing Functions, Miscellaneous Functions, Mathematical Functions, and Conversion Functions.

6.  Click Timeline Control to again trigger a collapsible list of the actual function coding.
7. Examine this list and look for “Stop”
8. Either double-click or select “Stop” from the list and drag it over to place the function command in the ActionScript window.
9. Note: the ActionScript window should display “stop();” minus the quotation marks.
Following these nine steps will have a user perform their first use of ActionScript. Pressing “Ctrl + Enter” will trigger the test movie command. This cause the instructions made by Flash to be read by the Flash player. When the movie is tested it may appear as nothing happened. In reality though, if the error message window does not appear show success with the first ActionScript command. This means your ​​​Flash clip executed and ran successfully and it stopped playing the movie at frame 10. Good job if no error messages appeared.
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Yes, it sounds exciting to successfully use ActionScript but better achievements are definitely needed. You do not want to stop here and think this language has been mastered. Showing this ActionScript to other people will not raise any eyebrows. The reason why of success is overshadowed is because our workspace is completely empty. The only thing existing in the workspace is a lone single Stop command. In order to overcome being overshadowed will require some elements to be placed in the Flash workspace. An element like a button is a good choice to showoff ActionScript features.

To Flash, a button is a symbol. A user can create any shape and make it a button. Buttons have four different states.
 These include :
1. Up - The default button state and occurs when the mouse pointer is not over the mouse button.
2. Over – The state when the mouse cursor is over the button

3. Down – The state when the mouse pointer is over the button and the mouse button is down.

4. Hit – The invisible area on the screen where the active area is the button.

The following steps will create a quick application showing use of a button. We will create a couple of textboxes and a button. The user can type there name in textbox 1 and then proceed to press the enter button. ActionScript will be added to the button to display a “hello message” with the user entered name included. For example, typing Anthony in textbox 1 will display “Hi there, Anthony” in textbox 2 after the button has been pressed:
1. Launch Flash

2. Select Modify -> Document to open the document’s properties dialog box to change background color.

3. Flash contains some pre-built buttons to be used for applications. These buttons are saved in the Flash library. To access the buttons select Window -> Other Panels -> Common Libraries -> Buttons
This will bring the button library to the stage. 

4. Select a button and drag it to the stage.

5. Using the move tool select the button and move it toward the bottom of the stage.

6. Selecting Windows->Align will help position the button to the desired position at the bottom center of the stage.

7. Next, the textboxes will be added. Select the text tool from the toolbar.

8. Click and drag on the stage to create a textbox. 
9. Select the textbox properties inspector. The properties inspector is located at the bottom in the same area as the ActionScript area.

10. Inside the property inspector you should see a drop-down menu with Static Text showing. Select the drop-down menu and select Input Text. This move will make your textbox able to input text.

11. Look to the right of this drop-down menu and you should see window for Font size. Increase the Font size to 24.

12. To the right of this window is a window to select text color. Pick a color.

13. Below the text color window is a textbox marked by the var label and is the place where you can type a variable name. We are using this textbox to have the user enter their name into. To keep it simple we will “name” into the textbox.
14. Now we need to add another textbox for our output message to appear on. The quickest way to do this is copy selecting the existing textbox and doing the copy and paste procedure. Edit -> Copy followed by Edit -> Paste.
15. Select the new textbox and look into its property inspector.

16. Textbox two will be used for output instated of input. We need to change the text type to Dynamic Text.

17. In the var textbox enter “welcome” to name this textbox welcome.

Alright, these are the steps which have to be done to setup this example properly. After the setup is when ActionScript is incorporated.

18. Select the button using the arrow tool and press F9 to open the ActionScript window. 

19.  Inside the ActionScript window type the following code:

on (release) {
    welcome = “Hi there, “ + name;
{

You can now see why we gave variable names to the textboxes. The breakdown of this ActionScript is the code is executed after the button has been clicked by the mouse and the mouse button is released. This triggers an output message to appear in the welcome textbox saying the “Hi there” message with whatever date was entered into the textbox “name”. Your output should look something like these images:
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These two examples of ActionScript should give an ideal on how this programming language works. Hopefully, these examples illustrate the ease of using ActionScript can be. 
3.4 ActionScript’s Similarities


 Researching ActionScript shows this language share many similarities to other programming languages like Java and Visual Basic. 
 
ActionScript consists of objects which get functions attached to them to perform certain required tasks. In the second example, variable names were given to the textboxes. Without this capability, ActionScript would have had no idea what textbox to grab data from or which textbox to display the greeting message in. Being able to declare variables paves the way to incorporate more sophisticated programming by using the “IF statement” to your applications.

A shape could be moved across the stage using an IF statement. The following is an example of an ActionScript “IF” statement:
onClipEvent(enterFrame) {

IF (_x < 450) {

_x = _x + 5;

}

}

This If Statement is saying an object like a circle will move 5 pixels on every frame if the coordinate of the x axis is under 450.


Another similarity ActionScript has with other programs is it has a debugger. The debugger can be activated by clicking its button located in the upper right corner of the ActionScript window. The ActionScript debugger works very similar to other debuggers by allowing users to place breakpoints and using the watch feature to examine date values for variables running in the ActionScript.


Last, I noticed ActionScript shares the same similarity of being case sensitive with coding. When coding in ActionScript you have to pay attention to because if you type string.tolowercase() you will generate errors when the movie is tested. To avoid these errors requires the correct code of string.toLowerCase() to be used. 


5. Conclusion
             The most important fact learned from researching ActionScript is that it does provide the extra potential and power in creating Flash applications. My previous work in Flash had my movie clips consisting of many frames. Using ActionScript reduces the required amount of frames to be only one. I could never imagine that until I took the bold move to learn ActionScript. This move has inspired me to try and get back into the realm of the 3D program MAYA and attempt to learn the Maya Embedded Language.


Until that day becomes a reality I will spend some more time building my knowledge of ActionScript. My feeling is what I have read is only scratching the surface of what ActionScript can do. The more time spent learning this scripting language could only be beneficial to earning a good living doing something exciting and enjoyable as making wonderful website applications. 

I want to pursue employment utilizing graphical software. Ideally, I want to have a full length animation show on television. My thought is I have to start somewhere, presumably small, and grow from there. I view learning ActionScript and its potential as a means to reach my animation goals.

Personally, I think my time spent working with this scripting language is small and plan to continue learning more. My thought is the potential of living in a small populated area like Durango, Colorado, population around 15,501
, and being of the only people with an established knowledge on how to use ActionScript for web based applications will be helpful to my future plans.
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